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Safety Information

The CY8CKIT-048 PSoC® Analog Coprocessor Pioneer Kit is intended for use as a development

platform for hardware or software in a laboratory environment. The board is an open system design,

which does not include a shielded enclosure. For this reason, the board may cause interference with

other electrical or electronic devices in close proximity. In a domestic environment, this product may

cause radio interference. In such cases, the user may be required to take adequate preventive

measures. Also, this board should not be used near any medical equipment or RF devices.

Attaching additional wiring to this product or modifying the product operation from the factory default

may affect its performance and cause interference with other apparatus in the immediate vicinity. If

such interference is detected, suitable mitigating measures should be taken.

The PSoC Analog Coprocessor Pioneer Kit, as shipped from the factory, has been verified to meet

with the requirements of CE as a Class A product.

General Safety Instructions

ESD Protection

ESD can damage boards and associated components. Cypress recommends that the user perform

procedures only at an ESD workstation. If an ESD workstation is not available, use appropriate ESD

protection by wearing an antistatic wrist strap attached to a grounded metal object.

Handling Boards

PSoC Analog Coprocessor Pioneer Kit is sensitive to ESD. Hold the board only by its edges. After

removing the board from the box, place it on a grounded, static-free surface. Use a conductive foam

pad if available. Do not slide the board over any surface.

The PSoC Analog Coprocessor Pioneer Kit contains ESD-sensitive devices.

Electrostatic charges readily accumulate on the human body and any

equipment which can cause a discharge without detection. Permanent damage

may occur to devices subjected to high-energy discharges. Proper ESD

precautions are recommended to avoid performance degradation or loss of

functionality. Store unused PSoC Analog Coprocessor Pioneer Kit in the

protective shipping package.

End-of-Life/Product Recycling

The end-of-life cycle for this kit is five years from the date of manufacture mentioned

on the back of the box. Contact the nearest recycler to discard the kit.
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1. Introduction

Thank you for your interest in the CY8CKIT-048 PSoC® Analog Coprocessor Pioneer Kit. This kit

enables you to evaluate and develop your application using the PSoC Analog Coprocessor device

family. The PSoC Analog Coprocessor simplifies the design of sensor-based systems by delivering a

scalable and reconfigurable architecture that integrates programmable Analog Front Ends (AFEs). It

has a signal processing engine (32-bit ARM® Cortex®-M0+) to calibrate and tune the AFE in

software. Additionally, the PSoC Analog Coprocessor enables applications to send aggregated, pre-

processed, and formatted sensor data over serial communication interfaces to host processors.

Systems that use multiple analog sensors usually require multiple specialized ICs to implement the

AFE, which increases BOM cost and PCB size. Systems designed for IoT applications must

combine data from multiple sensors to enable new sensing capabilities, commonly known as sensor

fusion. Sensor fusion solutions often require custom AFEs. The PSoC Analog Coprocessor reduces

the need for specialized ICs, offering the ability to create custom AFEs in a single-chip solution.

Figure 1-1 shows the analog sensors interface on PSoC Analog Coprocessor Pioneer Kit. 

The PSoC Analog Coprocessor Pioneer Kit offers footprint-compatibility with Arduino™ shields and

baseboards. This kit features five analog sensors. They are pyroelectric infrared (PIR) motion

sensor, thermistor, humidity sensor, ambient light sensor (ALS), and inductive proximity sensor

(IPS). It has an RGB LED, two user-configurable push-button switches, one reset push-button

switch, an onboard programmer/debugger with USB-UART/I2C bridge, and a Cypress F-RAM™.

This kit supports operating voltages of 1.8 V, 3.0 V, 3.3 V, or 5 V.

If you are new to PSoC Creator, see the documentation on the PSoC Creator home page. You can

also refer the application note, AN211293 – Getting Started with PSoC Analog Coprocessor, which

gives an introduction to the PSoC Analog Coprocessor.

Figure 1-1.  Analog Sensors
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1.1 Kit Contents

The PSoC Analog Coprocessor Pioneer Kit contains the following:

■ PSoC Analog Coprocessor Pioneer board

■ USB Standard-A to Mini-B cable

■ Four jumper wires (4 inches each)

■ Five connectors (one 10x1, two 8x1, one 6x1, and one 4x1)

■ One metal disk

■ Quick Start Guide

Figure 1-2.  Kit Contents

Inspect the contents of the kit; if you find any part missing, contact your nearest Cypress sales office

for help: www.cypress.com/support. 
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1.2 Board Details

As shown in Figure 1-3, the PSoC Analog Coprocessor Pioneer Kit features five onboard sensors.

The kit has two user buttons and an RGB LED. It also has a reset button, a power LED, and three

status LEDs. The kit can be powered from three power sources: USB, coin cell, or an external power

supply. Refer to Power Supply System on page 40 for details. There is a power selection jumper

(J9), which allows you to select the kit operating voltage. The kit can operate at 1.8 V, 3.3 V, or 5 V

when powered from the USB connector or external power supply and will operate at 3.0 V when

powered from the coin cell. The USB connector is used as a power source and for programming and

debugging your application on the PSoC Analog Coprocessor.

Figure 1-3.  PSoC Analog Coprocessor Pioneer Kit Top View
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Figure 1-4.  PSoC Analog Coprocessor Pioneer Board Pinout 

Table 1-1.  Jumpers/Switches Default Position

Jumper/Switch Purpose Default Position

J9 System Power (VDD Voltage) Selection 1–2 (3.3V)

J14 Shunt Selection for Current Measurement 3–4 (NO SHUNT)

J17 Humidity Sensor Calibration
1–2 (SENSOR 

CONNECTED)

SW4 VDD Source Selection REG

SW5 Power Domain Monitor Selection DIGITAL
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1.3 PSoC Creator

PSoC Creator is a free Windows-based Integrated Design Environment (IDE). It enables concurrent

hardware and firmware design of systems based on PSoC 3, PSoC 4, PSoC 5LP, and PSoC Analog

Coprocessor. See Figure 1-5. With PSoC Creator, you can:

1. Drag and drop Components to build your hardware system design in the main design workspace

2. Co-design your application firmware with the PSoC hardware

3. Configure Components using configuration tools

4. Explore the library of 100+ Components

5. Review Component data sheets

Figure 1-5.  PSoC Creator Features

PSoC Creator also enables you to tap into an entire tool ecosystem with integrated compiler chains

and production programmers for PSoC devices.

For more information, visit www.cypress.com/psoccreator.

PSoC Creator Code Examples

PSoC Creator includes a large number of code examples. These examples are accessible from the

PSoC Creator Start page, as shown in Figure 1-6.

Code examples can speed up your design process by starting you off with a complete design,

instead of a blank page. The code examples also show how to use PSoC Creator Components for

various applications. Code examples and documentation are included, as shown in Figure 1-7.

In the Find Example Project dialog shown in Figure 1-7, you have several options:

■ Filter for examples based on a device family or keyword.

■ Select from the list of examples offered based on the Filter Options.

■ View the project documentation for the selection (on the Documentation tab).

■ View the code for the selection on the Sample Code tab. You can also copy and paste code from 

this window to your project, which can help speed up code development.
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■ Create a new workspace for the code example or add to your existing workspace. This can speed 

up your design process by starting you off with a complete, basic design. You can then adapt that 

design to your application.

Figure 1-6.  Code Examples in PSoC Creator
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Figure 1-7.  Code Example Projects with Sample Code

Kit Code Examples:

You can access the installed kit code examples from the PSoC Creator Start Page. To access these

examples, expand Kits under the section Examples and Kits; then, expand the specific kit to see

the code examples. Refer to the Code Examples chapter on page 36 for a list of code examples that

you can use on this kit. 

PSoC Creator Help:

Launch PSoC Creator and navigate to the following items:

■ Quick Start Guide: Choose Help > Documentation > Quick Start Guide. This guide gives you 

the basics for developing PSoC Creator projects.

■ Simple Component Code Examples: Choose File > Code Example. These examples demon-

strate how to configure and use PSoC Creator Components. To access examples related to a 

specific Component, right-click on the Component in the schematic or in the Component Catalog. 

Select the Find Code Example option in the context menu that appears. 

■ System Reference Guide: Choose Help > System Reference > System Reference Guide. 

This guide lists and describes the system functions provided by PSoC Creator.

■ Component Datasheets: Right-click a Component and select Open Datasheet. Visit the 

PSoC Analog Coprocessor Component Datasheets page for a list of all PSoC Analog Coproces-

sor Component datasheets.

■ Document Manager: PSoC Creator provides a document manager to help you easily find and 

access the document resources. To open the document manager, choose the menu item Help > 

Document Manager.
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1.4 Getting Started

This guide will help you get acquainted with the PSoC Analog Coprocessor Pioneer Kit:

■ The Software Installation chapter on page 15 describes the installation of the kit software. This 

includes the PSoC Creator IDE to develop and debug the applications, and PSoC Programmer to 

program the .hex files on to the device.

■ The Kit Operation chapter on page 18 describes the major features of the PSoC Analog Copro-

cessor Pioneer Kit and functionalities such as programming, debugging, and the USB-UART and 

USB-I2C bridges.

■ The Code Examples chapter on page 36 describes multiple PSoC Analog Coprocessor code 

examples that will help you understand how to create your own PSoC projects.

■ The Appendix on page 39 provides the detailed hardware description, method to use the onboard 

F-RAM, kit schematics, and the bill of materials (BOM).

1.5 Additional Learning Resources

Cypress provides a wealth of data at www.cypress.com to help you to select the right PSoC device

for your design, and to help you to quickly and effectively integrate the device into your design. For a

comprehensive list of resources, see KBA86521 - How to Design with PSoC 3, PSoC 4, and

PSoC 5LP. The following is an abbreviated list for PSoC Analog Coprocessor:

■ Overview: PSoC Portfolio and PSoC Roadmap.

■ Product Selectors: PSoC Analog Coprocessor Product Selector. In addition, PSoC Creator 

includes a device selection tool.

■ Datasheets describe and provide electrical specifications for the PSoC 4000, PSoC 4100, 

PSoC 4200, PSoC 4100M, PSoC 4200M, PSoC 4200L, PSoC 4000S and PSoC Analog 

Coprocessor device families.

■ Getting Started with PSoC Analog Coprocessor provides information on how to get started with 

PSoC Analog Coprocessor. 

■ CapSense Design Guide: Learn how to design capacitive touch-sensing applications with the 

PSoC 4 and PSoC Analog Coprocessor family of devices.

■ Application Notes and Code Examples cover a broad range of topics, from basic to advanced. 

Many of the application notes include code examples. Visit the PSoC 3/PSoC 4/PSoC 5LP Code 

Examples web page for a list of all available PSoC Creator code examples. To access code 

examples from within PSoC Creator – see PSoC Creator Code Examples on page 9.

■ Technical Reference Manuals (TRM) provide detailed descriptions of the architecture and regis-

ters for each of the PSoC 4 and PSoC Analog Coprocessor family of devices.

■ Development Kits:

❐ CY8CKIT-041, CY8CKIT-046, CY8CKIT-044, CY8CKIT-042, CY8CKIT-040 and CY8CKIT-

048 are easy-to-use and inexpensive development platforms. These kits include connectors 

for Arduino-compatible Shields and Digilent Pmod Peripheral Modules.

❐ CY8CKIT-049 and CY8CKIT-043 are very low-cost prototyping platforms for sampling PSoC 4 

devices.

❐ CY8CKIT-001 is a common development platform for all PSoC family devices.

❐ The MiniProg3 device provides an interface for flash programming and debug.

■ Knowledge Base Articles (KBA) provide design and application tips from experts on using the 

device. 

■ PSoC Creator Training: Visit www.cypress.com/go/creatorstart/creatortraining for a comprehen-

sive list of video trainings on PSoC Creator.
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■ Learning from Peers: Visit www.cypress.com/forums to meet enthusiastic PSoC developers dis-

cussing the next-generation embedded systems on Cypress Developer Community Forums.

1.6 Technical Support

For assistance, visit Cypress Support or contact customer support at +1(800) 541-4736 Ext. 2 (in the

USA) or +1 (408) 943-2600 Ext. 2 (International).

You can also use the following support resources if you need quick assistance:

■ Self-help (Technical Documents) 

■ Local Sales Office Locations 

1.7 Documentation Conventions

1.8 Acronyms

Table 1-2.  Document Conventions for Guides

Convention Usage

Courier New
Displays file locations, user entered text, and source code:

C:\...cd\icc\

Italics
Displays file names and reference documentation:

Read about the sourcefile.hex file in the PSoC Creator User Guide.

[Bracketed, Bold]
Displays keyboard commands in procedures:

[Enter] or [Ctrl] [C]

File > Open
Represents menu paths:

File > Open > New Project

Bold
Displays commands, menu paths, and icon names in procedures:

Click the File icon and then click Open.

Times New Roman
Displays an equation:

2 + 2 = 4

Text in gray boxes Describes cautions or unique functionality of the product.

Table 1-3.  Acronyms Used in this Document

Acronym Definition

ADC Analog-to-Digital Converter

AFE Analog Front End

AMUX Analog Multiplexer

BOM Bill of Materials

CMP Comparator

CPU Central Processing Unit

DAC Digital to Analog Convertor

DC Direct Current

DNL Differential Non-Linearity

DPDT Double-Pole, Double-Throw

ESD Electrostatic Discharge

F-RAM Ferroelectric Random Access Memory
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FET Field-effect Transistor

GPIO General-Purpose Input/Output

HPF High Pass Filter

IC Integrated Circuit

ICSP In-Circuit Serial Programming

IDAC Current DAC

IDE Integrated Design Environment

IoT Internet of Things

IR Infrared

I2C Inter-Integrated Circuit

LCD Liquid Crystal Display

LED Light-emitting Diode

LPF Low Pass Filter

LSB Least Significant Bit

PCB Printed Circuit Board

PGA Programmable Gain Amplifier

PIR Pyroelectric Infrared

PPTC Polymeric Positive Temperature Coefficient

PRB Programmable Reference Block

PSoC Programmable System-on-Chip

PWM Pulse Width Modulation 

RGB Red Green Blue

SAR Successive Approximation Register

SCB Serial Communication Block

SNR Signal-to-Noise Ratio

SPI Serial Peripheral Interface 

SRAM Serial Random Access Memory

SWD Serial Wire Debug

TIA Transimpedance Amplifier

UART Universal Asynchronous Receiver Transmitter

USB Universal Serial Bus

WCO Watch Crystal Oscillator

Table 1-3.  Acronyms Used in this Document (continued)

Acronym Definition
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2. Software Installation

This chapter describes the steps to install the software tools and packages on a PC for using the

PSoC Analog Coprocessor Pioneer Kit. This includes the IDE on which the projects will be built and

used for programming.

2.1 Before You Begin

To install Cypress software, you will require administrator privileges. However, this is not required to

run software that is already installed. Before you install the kit software, close any other Cypress

software that is currently running.

2.2 Install Software

Follow these steps to install the PSoC Analog Coprocessor Pioneer Kit software:

1. Download the PSoC Analog Coprocessor Pioneer Kit software from www.cypress.com/

CY8CKIT-048. The kit software is available in three different formats for download:

a. CY8CKIT-048 Kit Complete Setup: This installation package contains the files related to the 

kit. However, it does not include the Windows Installer or Microsoft .NET framework pack-

ages. If these packages are not on your computer, the installer directs you to download and 

install them from the Internet.

b. CY8CKIT-048 Kit Only: This executable file installs only the kit contents, which include kit 

code examples, hardware files, and user documents. This package can be used if all the soft-

ware prerequisites (listed in step 5) are installed on your PC.

c. CY8CKIT-048 DVD ISO: This file is a complete package, stored in a DVD-ROM image format, 

which you can use to create a DVD or extract using an ISO extraction program such as 

WinZip® or WinRAR. The file can also be mounted similar to a virtual CD/DVD using virtual 

drive programs such as Virtual CloneDrive and MagicISO. This file includes all the required 

software, utilities, drivers, hardware files, and user documents.

2. If you have downloaded the ISO file, mount it on a virtual drive. Extract the ISO contents if you do 

not have a virtual drive to mount. Double-click cyautorun.exe in the root directory of the extracted 

content or the mounted ISO if “Autorun from CD/DVD” is not enabled on the computer. The 

installation window will appear automatically. 

Note: If you are using the “Kit Complete Setup” or “Kit Only” file, then go to step 4 for installation.
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3. Click Install CY8CKIT-048 to start the PSoC Analog Coprocessor Pioneer Kit installation, as 

shown in Figure 2-1.

Figure 2-1.  Kit Installer Screen 

4. Select the folder in which you want to install the PSoC Analog Coprocessor Pioneer Kit-related 

files. Choose the directory and click Next.

5. When you click Next, the installer automatically installs the required software, if it is not present 

on your computer. The following are the required software:

a. PSoC Creator 3.3 Component Pack 3 (CP3) or later: This software is available separately 

from www.cypress.com/psoccreator.

b. PSoC Programmer 3.24.2 or later: This is installed as part of PSoC Creator installation or is 

available separately from www.cypress.com/programmer.
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6. Choose the Typical, Custom, or Complete installation type (select Typical if you do not know 

which one to select) in the Product Installation Overview window, as shown in Figure 2-2. Click 

Next after you select the installation type.

Figure 2-2.  Product Installation Overview

7. Read the License agreement and select I accept the terms in the license agreement to con-

tinue with installation. Click Next.

8. When the installation begins, a list of packages appears on the installation page. A green check 

mark appears next to each package after successful installation.

9. Enter your contact information or select the Continue Without Contact Information check box. 

Click Finish to complete the PSoC Analog Coprocessor Pioneer Kit software installation.

10. After the installation is complete, the kit contents are available at the following location:

 <Install_Directory>\CY8CKIT-048 PSoC Analog Coprocessor Pioneer Kit

Default location: 

Windows 7 (64-bit): C:\Program Files (x86)\Cypress\CY8CKIT-048 PSoC Analog 

Coprocessor Pioneer Kit

Windows 7 (32-bit): C:\Program Files\Cypress\CY8CKIT-048 PSoC Analog 

Coprocessor Pioneer Kit

Note: For Windows 7/8/8.1/10 users, the installed files and the folder are read-only. To use the 

installed code examples, follow the steps outlined in the Code Examples chapter on page 36. 

These steps will create an editable copy of the example in a path that you choose so the original 

installed example is not modified.

2.3 Uninstall Software

The software can be uninstalled using one of the following methods:

■ Go to Start > All Programs > Cypress > Cypress Update Manager and select the Uninstall 

button that corresponds to the kit software.

■ Go to Start > Control Panel > Programs and Features for Windows 7 or Add/Remove 

Programs for Windows XP; choose the product and select the Uninstall/Change button.
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3. Kit Operation

This chapter introduces you to the various features of the PSoC Analog Coprocessor Pioneer Kit,

including the theory of operation and the onboard programming and debugging functionality.

3.1 Theory of Operation

Figure 3-1 shows a generic block diagram of a sensor-based system, which includes:

1. An AFE to condition the sensor outputs by amplifying and filtering the signals.

2. An analog-to-digital converter (ADC) or a comparator (not shown in below image) to convert the 

conditioned sensor output into digital data.

3. A programmable signal processing engine with a serial communication interface, to format the 

sensor data and send it to the host processor.

Figure 3-1.  Sensor-Based System 

The PSoC Analog Coprocessor Pioneer Kit consists of four blocks. They are PSoC Analog

Coprocessor, analog sensors, KitProg2, and power supply.

The PSoC Analog Coprocessor block consists of the PSoC Analog Coprocessor device. Figure 3-2

shows the block diagram of the PSoC Analog Coprocessor block. See PSoC Analog Coprocessor

on page 20 for more details on the feature set.

The analog sensors block consists of five onboard sensors. They are PIR motion sensor, ambient

light sensor, thermistor, inductive proximity sensor, and humidity sensor. The output of the analog

sensors is fed to the PSoC Analog Coprocessor block. Figure 3-2 shows the block diagram of the

sensors block. See Analog Sensors on page 23 for more details on this block.

The KitProg2 block is used to program and debug the PSoC Analog Coprocessor through an

onboard PSoC 5LP device. It connects to the USB port of a PC through a USB connector. It

supports SWD programming/debugging and also includes a USB-I2C/USB-UART bridge interface

for the PSoC Analog Coprocessor. Figure 3-3 shows the block diagram of the KitProg2 block. See

KitProg2 on page 31 for more details on this block.

The power supply block enables the board to operate at 1.8 V, 3.0 V, 3.3 V, and 5.0 V. It has the

provision to be powered from three power sources: external power supply, USB, or a coin cell. The
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multi-voltage operation is achieved using a Cypress Power Management IC (PMIC). The operating

voltage can be selected using a power selection jumper (J9). Figure 3-4 shows the block diagram of

the power supply block. See Power Supply on page 31 for more details on this block. 

Figure 3-2.  Block Diagram of PSoC Analog Coprocessor and Analog Sensors 

Figure 3-3.  Block Diagram of KitProg2 
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Figure 3-4.  Block Diagram of Power supply 

3.1.1 PSoC Analog Coprocessor

The PSoC Analog Coprocessor device has an extensive set of analog features and other resources. 

Figure 3-5.  PSoC Analog Coprocessor Block Diagram
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Given below is a list of major features of the PSoC Analog Coprocessor device. 

Operating Range and Low-Power Modes

■ Device operating voltage 1.71 V to 5.5 V

■ Sleep mode switches off clocks to the CPU. 3.1 mA typical current at 12 MHz.

■ Deep-Sleep mode with operational analog. 2.5 µA typical current.

Programmable Analog Blocks

■ Universal Analog Block (UAB)

The UAB can be configured as one of the following:

❐ 12-bit buffered voltage DAC (VDAC), with a sample rate of 500 kHz

❐ 2nd-order bi-quad filter, as a low-pass, high-pass, band-pass, or notch filter

❐ 12-bit delta-sigma ADC, with a sample rate of 7.8 ksps and a DNL of ±1 LSB 1

❐ 14-bit incremental delta-sigma ADC, with a sample rate of 100 sps and a DNL of ±2 LSB 2

■ Four programmable opamps

❐ 90 dB open-loop gain, rail-to-rail operation

❐ Can be used with external components to form standard opamp circuits

❐ Can use an internal resistor array to form a programmable gain amplifier (PGA) with gain up

to 32

❐ 6 MHz gain-bandwidth when driving external I/Os, with up to 10-mA drive

❐ 8 MHz gain-bandwidth when driving internal nodes such as the SAR ADC

❐ ±1 mV input offset voltage

❐ 15 µA operating current in Deep-Sleep mode

■ Two low-power comparators (CMP)

❐ Wake up the device from low-power modes

■ 12-bit SAR ADC

❐ Sample rate up to 1 Msps

❐ Selectable resolution 8-, 10-, or 12-bit

❐ Automated hardware sequencer with 16 input channels

❐ Each channel can be differential or single-ended

❐ Integrated hardware averaging per channel

❐ Programmable input channels, for example external pins, opamps, and UAB

■ Single-Slope ADC

❐ Selectable 8- or 10-bit resolution

❐ Sample rate up to 11.6 ksps with 10-bit resolution

❐ Input measurement range from VSS to VDDA on any GPIO pin

❐ Implemented in the CapSense® block

■ Programmable Reference Block (PRB)

❐ Four voltage references, independently adjustable in 16 steps, from VDDA to VSS, or 1.2 V to

VSS

1. Component support to be made available in future.

2. Component support to be made available in future.
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❐ References can be routed to internal high-impedance analog resources: ADC, VDAC,

comparator, and opamps.

❐ References can also be routed to a GPIO if buffered through an opamp.

■ CapSense

❐ Measures capacitance; can be used with capacitive sensors such as in liquid level or touch 

sensing applications

❐ Self- and mutual-capacitive sensing methods

❐ Improved electromagnetic interference (EMI) using spread spectrum clock and programmable 

slew rate control

■ IDACs

❐ Two 7-bit current DACs (IDACs) for use with CapSense or for general-purpose applications

❐ A single 8-bit IDAC can be created by combining the two IDACs in parallel

❐ 37.5 nA LSB current for precise capacitance measurements

❐ Six output current ranges (4.76 µA to 609 µA) in source or sink configuration

32-bit Signal Processing Engine

■ ARM Cortex-M0+ CPU, operating at up to 48 MHz

■ Up to 32 KB of flash with read accelerator

■ Up to 4 KB of SRAM

■ 8-channel direct memory access (DMA) controller

■ Watch crystal oscillator (WCO) for real-time clock (RTC) applications

■ Three serial communication blocks (SCBs), each configurable as SPI, I2C, or UART

■ Eight 16-bit timer / counter / pulse-width modulator (TCPWM) blocks

I/O Subsystem

■ Up to 38 GPIOs that can be used for analog, digital, CapSense, or segment LCD functions

■ Programmable drive modes and slew rates

■ Eight Smart I/Os that can implement Boolean operations on pin signals
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3.1.2 Analog Sensors

Analog sensors generally come in five different types, depending on their output electrical signal:

voltage, current, resistance, capacitance, or inductance. Each sensor type requires a specific AFE

design as shown in Table 3-1. The PSoC Analog Coprocessor provides resources to build all of

these AFEs, thus reducing the BOM cost and PCB size. The PSoC Analog Coprocessor contains

opamp, comparators, programmable gain amplifiers (PGA), programmable reference block (PRB)

and analog multiplexers (AMUX), which are the building blocks of different type of AFEs.

The remaining part of this section contains details of interfacing the PSoC Analog Coprocessor with

each of the sensors mentioned in Table 3-1. For example, Interfacing with a PIR Motion Sensor on

page 23 explains how to use opamps inside the PSoC Analog Coprocessor to implement a voltage

amplifier circuit. 

3.1.2.1 Interfacing with a PIR Motion Sensor

The PIR motion sensor is based on the pyroelectric effect, where certain materials generate a

voltage when exposed to infrared radiation. This radiation is the portion of the electromagnetic

spectrum that falls between microwaves and visible light. Infrared radiation has wavelengths longer

than the visible light but shorter than microwaves. Humans at normal body temperature radiate

strongest in the infrared range at an approximate wavelength of 10 µm. 

The PIR motion sensor uses infrared-sensitive materials as the sensing elements. It is packaged

with a field-effect transistor (FET) in the Source Follower mode, as Figure 3-6 shows. An FET is

required to buffer the high-impedance output of the sensor element. When the sensor element is

exposed to infrared radiation, a voltage is generated across the element. 

Figure 3-6.  PIR Motion Sensor – Single-Element 

Table 3-1.  AFE Requirements for Different Sensors

Analog Sensor Output Signal AFE Sensor Part

PIR motion sensor (Refer to Interfacing 

with a PIR Motion Sensor on page 23)
Voltage Voltage amplifier Zilog ZRE200GE

Ambient light sensor (Refer to 

Interfacing with an Ambient Light 

Sensor on page 26)

Current
Transimpedance 

amplifier
Vishay TEMD6200FX01

Thermistor (Refer to Interfacing with a 

Thermistor on page 27)
Resistance

Programmable 

voltage reference

EPCOS (TDK) 

B57164K103J

Inductive proximity sensor (Refer to 

Interfacing with an Inductive Proximity 

Sensor on page 28)

Inductance
HPF-Down Mixer-

Rectifier
N/A (PCB trace)

Humidity sensor (Refer to Interfacing 

with a Humidity Sensor on page 29)
Capacitance

Charge transfer 

circuit
HPP801A031
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Most of the common PIR motion sensors have two or four sensing elements. These elements are

arranged such that the voltage generated by one is subtracted by the other. This arrangement

cancels the common signal and generates a voltage only when there is a difference in the incident

infrared radiation level on the sensing elements.

Figure 3-7 shows the dual-element PIR motion sensor with the elements connected in series but

with an opposite phase, because of which it has the maximum sensitivity along a particular axis.

Figure 3-7.  PIR Motion Sensor Dual-Element 

The sensor package is designed to have a unique field-of-view for each element. When an IR

radiating source moves across the fields of view, the sensor generates a differential signal (see

Figure 3-8). For a 90° field-of-view or more, a Fresnel lens is mounted on the PIR motion sensor. It

improves the sensitivity and thus the detection distance.

Figure 3-8.  PIR Motion Sensor Output Response 
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Figure 3-9 shows the PSoC Creator schematic for interfacing a PIR motion sensor with the PSoC

Analog Coprocessor.

Figure 3-9.  Interfacing PSoC Analog Coprocessor with PIR Motion Sensor 

The PIR motion sensor implementation on the PSoC Analog Coprocessor Pioneer Kit consists of

five stages: a bias circuit for the PIR motion sensor, a first-stage amplifier, a high-pass filter (HPF), a

second-stage amplifier, and an ADC. In the main stages of the PIR motion sensor implementation,

the two amplifiers are implemented in the PSoC Analog Coprocessor. 

The PSoC Analog Coprocessor Pioneer Kit has a dual-element PIR motion sensor (ZRE200GE).

The voltage signal generated by the sensor is AC-coupled (using C48) and clamped to the internal

reference voltage generated from PVref Component. The typical sensor output voltage is in the order

of several millivolts and varies depending on the strength of the incident infrared radiation. To detect

the motion of a human body at a distance of 10 feet, a gain of >1000 is required. A single-stage

amplifier with such a high gain causes the amplifier output to saturate due to the amplification of the

input offset voltage. Thus, a two-stage amplifier is best suited for amplifying with a high gain.

The total gain is split between two stages. The first-stage amplifier uses a noninverting amplifier

configuration using an internal opamp and external gain setting resistors, R118 and R119. The

second-stage amplifier uses a PGA Component. The first-stage amplifier gain is set to 681 and the

PGA gain is set to 1 on startup. However, the second-stage amplifier gain changes depending on the

detection distance required – 3 feet, 10 feet, or 20 feet.

An HPF, made using external passive components C91 and R147, is introduced between the first

and the second amplifier stages to eliminate the offset voltage.

The PIR motion sensor and gain stages use a 1.2-V system bandgap voltage as the reference

voltage. The bandgap voltage is independent of supply voltage fluctuations and hence provides a

stable voltage reference. This voltage is generated using a programmable voltage reference

component, PVref, and is buffered using an opamp.

The output of the second-stage PGA is connected to the Scanning SAR ADC Component. The

Scanning SAR ADC results are compared against threshold values to detect the motion of an IR

emitting object. 

For more details of firmware implementation, refer to the Code Example

CE211301_PIR_Motion_Sensing available in the kit installation directory. 
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